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Section 1

Introduction

Welcome to the STK200 Flash MCU Starter kit.

This system incorporates a sophisticated applications board, Atmel AVR ISP software
and an ISP dongle that will program any Atmel AVR microcontroller. 

For up to the minute information on this product and any manual errata, please read the
README.TXT file included with the software.

1.1 Device Support The system software currently has support for the following Atmel devices.

AVR Devices:
• AT90S1200
• AT90S2313
• AT90S/LS2323
• AT90S/LS2343
• AT90S4414
• AT90S/LS4434
• AT90S8515
• AT90S/LS8535

Software upgrades for the AVR ISP software is posted to the AVR section of the Atmel
website, which is located at http://www.atmel.com.
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Getting Started

1.2 Unpacking the 
System

Contents of box:

n Evaluation Board

n Disk set, including Atmel AVR ISP software

n In-System Programming (ISP) Dongle

n ISP Ribbon Cable

1.3 System 
Requirements

The minimum hardware and software requirements are:

n 80386 Processor (486 Recommended)

n 1MB Ram

n 1MB Free Hard Disk Space

n Windows 3.1 or Windows 95
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Section 2

Connecting the Hardware

A power supply is required with a standard 2.1mm barrel connector. It can be AC (7 -
12V) or DC (9 - 15V). The connector is inserted into the power connection socket as
shown, above.

The programming lead supplied is fitted into the Dongle case and the other end is
inserted into the programming interface on the board as shown.

The Dongle case is connected to one of the printer ports on the PC. If this is not LPT1,
then you will need to change the printer port setting in the software—see software sec-
tion for details.

PLUG HEADER ON LEAD 
INTO PROGRAMMING 
INTERFACE - KEY WAY 
GIVES ORIENTATION

CONNECT LEAD
SUPPLIED TO DONGLE

AND INSERT IN
PC PRINTER PORT

POWER SUPPLY
9 - 15V DC
7 - 12V AC

ON-OFF SWITCH
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Section 3

Hardware Description

The main features of the board are shown in the following diagram.

Note: There are a number of jumpers on the board which are used to select different 
operations and voltages. The default jumper settings are for programming oper-
ations at 5V. To carry out other operations, some jumpers may have to be 
removed - refer to the relevant section for details. A full list of the jumpers and 
links are given in Section 3.1.

LCD CONTRAST
ADJUSTMENT

LCD CONNECTOR

ANALOG REFERENCE
VOLTAGE ADJUSTMENT

28-PIN A/D 
PARTS (FUTURE)

40-PIN 
A/D PARTS

LK1 - CUT FOR A/D 
EXTERNAL REFERENCE

ANALOG I/P

PORT A DIGITAL

SOCKET FOR 
40-PIN DIGITAL PARTS

PORT B - ALL PARTS

PORT C - ALL PARTS
EXCEPT 28-PIN
JP3 - JUMPER FOR
RXD ENABLE

PORT D JUMPERS
DISABLE SWITCHES

PORT D - ALL PARTS
EXCEPT 8 PIN

MISC. HEADER
FOR NON-PORT PINS

JP2 - JUMPER 
FOR BROWN-OUT 
AT 3.3V OR 5V

8 LEDS ON
PORT B

8 SWITCHES
ON PORT D

JP1 JUMPER FOR
3.3 OR 5V VCC SELECT

ON-OFF
SWITCH

POWER INPUT
9-15V DC

OR 7-12 AC

RS232

PORT B JUMPERS
DISABLE LEDS

4 MHZ CRYSTAL

20-PIN SOCKET

ISP INTERFACE

CLOCK SELECT
FOR 8-PIN SOCKET

8-PIN SOCKET

POWER ON LIGHT

EXTERNAL 
SRAM SOCKET

ADDRESS
LATCH SOCKET
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3.1 Jumpers and 
Links and Their 
Functions

3.2 External 
Connections

All Ports are brought out to edge of board on to headers. Each header has a VCC and
Ground pin for power supply to external circuits. Port A for A/D parts is on a separate
header from Port A for standard parts, labeled Analog. There is an extra six-pin header
for miscellaneous functions - ICP, OC1B and ALE on 40-pin Digital devices, Reset,
Ground and VCC. The external load cannot exceed 100 mA for all headers combined.

See sections on Using External Connections and Using Analog Parts for details.

Jumper Function Open Closed Default

JP1 Voltage select 5v 3.3V Open

JP2 Brown out select 2.9V 4.5V Closed

JP3 RS232 RXD OFF ON Open

Port B LEDs LEDs Disabled LEDs Enabled Closed

Port D Switches Switches Disabled Switches Enabled Closed

LK1
Analog Reference 
See Section 8.4.2

If LK1 cut then 
EXTERNAL REF 
from header

ONBOARD POT Closed

CUT Under 
Board

LCD Contrast
See Section 8.6

If Cut, add 
extra resistor

Contrast Pot Closed

Clock Sel
Selects Internal or 
External Clock for 
AT90S2323

INT = Internal Clock EXT = External Clock Closed
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Section 4

Installing the Software

4.1 Windows 95 To install the software, insert the supplied disk or CDROM in your computer and perform
the following steps:

1. Click on your Start button.

2. Select Settings.

3. Select Control Panel.

4. Choose Add/Remove Programs.

5. Click the Install button.

6. Follow On-Screen prompts.

The software will then be installed onto your computer and an Icon will be added to your
start menu. 

4.2 Windows 3.1 Choose RUN from Program Manager, and enter A:\SETUP.EXE as the filename.

Press the OK button and the software installation program will begin.

The software will then be installed onto your computer and an Icon and Program Group
will be added to Program Manager.

Note: On some PCs, especially laptops, programming problems may occur if the Bios 
Parallel Port settings are set to EPP Version 1.7. If programming problems do 
happen, ensure that the Parallel Port settings in your BIOS are set to EPP V1.9 
not V1.7.

In the unlikely event that you have any problems installing the software or suspect that
you have faulty media, please contact the Atmel Starter Kit hotline:

Hotline Number: (44) 1970 621 049

Fax Number: (44) 1970 621 040

E-mail: stk200_support@atmel.com
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Section 5

How to use the Software

The software is fully context-sensitive. This means that pressing F1 at any time will bring
up help information about the current option that you have selected.

Please note that the toolbar icons referred to in the text have ToolTip’s. If you want to
know the function of any particular button, hold your mouse pointer over the button in
question and its function will be displayed.

n Starting a Project

n In-System-Programming (ISP)

n Hardware Requirements

n Projects

n Data Files

n Editing Data

5.1 Projects If you have used a high-end professional development system you will be familiar with
the project concept. Essentially this is a collection of information which is managed by
the program on your behalf. In the AVR you have both Program Memory and non-vola-
tile Data Memory (EEPROM) and you have various security and device options. The
project manager keeps this information together for you so you do not have to remem-
ber and reload all the various files every time you use the programmer. 

It will also allow you to store information such as the project name and the project identi-
fier. Also included is a small notepad to store comments about the project. 

Before you can start a programming session you must either open an existing project or
start a new project. You can open a project, or create a new one, by either going to the
Project menu and selecting New or Open, or by using the 'New Project' or 'Open Project'
buttons on the toolbar.

5.2 Files Once a project is open, you can load the files that you want to program into the device.

Files may be loaded by either using the Load command in the File menu or by using the
Open icon on the toolbar.

The program will automatically decode your files whether they are in Intel Hex format,
Atmel Generic, Binary, or Motorola S record. The file you choose will be loaded into the
window, then it is displayed on the top of the desktop. If you have the EEPROM Data
Memory window on top, then it will load the data into that window.

Note that the AVR® Assembler which accompanies this program will produce the cor-
rect files for you ready to load into the buffers. You can save the buffer in Binary, Intel
Hex, or Atmel Generic formats, so you can use the buffer for code conversion.

Similarly it will load the data into the Program Memory if that is the window that is on top.
The program will not allow you to load data if the project manager window is on top. To
change which window is on top you can either click your mouse on any part of the win-
dow that is showing, go to the Window menu using Alt-W or the mouse and select the
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window of your choice or press Ctrl-F6. Note that the loaded data will show up in blue
text where the default, empty text color is black.

Once your data files are loaded you can start your programming session.

5.3 Editing Data Once a project has been started, you can either load a data file or you can insert your
own data in Hex or ASCII directly into the Program or EEPROM data windows.

With a new project, the data windows called buffers will contain FF in every location.
This is also what a new or erased device will contain.

You can move around in the current window by using the cursor keys. In order to see
memory further down the window, use the page up and page down keys on the key-
board.

You may change the data at any memory location by clicking on that location and typing
in the required hex values. Any changes you make will be reflected by the data changing
to green text. The ASCII character of the hex value will be shown alongside the data
window.

If you wish to edit the buffer in ASCII, either click on the right area of the window or
press Ctrl-A.

Once you have entered the required data then you can save the contents of the current
window by using either the Save icon on the toolbar or by pressing F2 (on the keyboard)
or by choosing the Save function in the File menu. 

5.4 Programming Read the section on Programming using the Board or Programming In-System before
programming parts.

Before you can start programming a device you must have a project open on the desk-
top.

5.5 Auto-Program The easiest and quickest method of programming a device is to use the Auto-program
option which is available in either the Program menu or by using the Auto-program icon
on the toolbar. If you use this option then you will be presented with a series of check
boxes to select which features you want to enable or disable during the programming
session. You can enable or disable any of the options by clicking on them or using
Arrow and Space keys. If the option has a check mark next to it then it is enabled, if not
then it is disabled. Note that the default is for all the options to be enabled. Further note
that you should not disable the erase function under normal circumstances.

If the Dongle is not plugged in to your printer port then you may get an error at this point.
If you get the Dongle not found error and it has been inserted into the printer port, make
sure that you have selected the correct printer port. You can change the printer port set-
ting by going to the Options menu and choosing Change Printer Port. Simply choose the
correct one for your system.

The programmer then attempts to read the device signature bytes. If they are not found
because you are using an old version of the device, no device is plugged in, the module
is switched off or the lock bits are set, a message box informs you of this. You have the
option of Abort, Retry or ignore.



How to use the Software

9  

Auto Program carries out all the steps you have selected. All these options are available
individually in the Program Menu and some of them also have Speed Buttons on the
toolbar.

n Erase Device

n Program Device

n Program EEPROM

n Verify Device

n Verify EEPROM

n Program Lockbits

The programmer has a dual function. In addition to being able to program a device out
of circuit using the applications module, you can also program a device which has been
soldered into your circuit. This allows you to solder in a blank device, program and
reprogram the device without removing it from the board. See the section on Program-
ming In-system for details. Both methods use the same user software.

5.6 New Project This creates a new project. You will be prompted for the device type in a dialogue box.
Select the device you wish to base your project around, and press the OK Button.

The system will then open a Project Manager & Buffer windows to set project options
and allow you to Open the Program and EEPROM files.

5.7 Open Project Open Project allows you to open an existing project, and all associated files, and set-
tings.

Choose Open Project from the Project Menu or use the Speed Button.

5.8 Save Project It is available on the Project Menu & the toolbar.

This allows you to save your project options including font settings, window positions,
and files in one quick easy step.

You are prompted for a project file name .AVR extension and if either the Program or
EEPROM buffers have changed, you will be prompted to save them also.

5.9 Load File This allows you to load a data file into your project. You must have the appropriate
buffer selected, Program or EEPROM on top of the desktop, when you choose Load File
in the File menu or click on the Load File button, as the file will be loaded into the cur-
rently open buffer.

The file loader currently has support for loading the following file types:

n Binary

n Intel Hex

n Motorola S Record

n Atmel Generic

The file type is automatically selected and requires no user intervention.

5.10 Save File This allows you to save a data file without saving the whole project. You must have the
appropriate buffer selected when you select Save File or Save File As, as the file in the
selected buffer will be saved.
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The Save File option currently has support for saving the data in the following file types:

n Binary

n Intel Hex

n Atmel Generic

To select the file type you want, select the file type from the save file as type pull down
box below the File name list in the Save File dialogue box.

5.11 Exit This will make the application close down. If you have recently made any changes to a
project, you will be prompted to save your project. 

You can exit the program by using the speed button, clicking the close icon on the pro-
gram window X or choosing Project - Exit.

5.12 Clear Buffer It is available on the Buffer menu.

This will cause the currently selected buffer to be cleared i.e. Filled with FF’s. Any data
currently in the buffer will be lost. Only the selected buffer will be cleared. 

5.13 Fill Buffer It is available on the Buffer menu.

A small dialogue box appears where you can select the start address Fill From, the end
address Fill To and the value to insert Fill With. The new value is inserted in all the
selected addresses and is shown as green text. 

5.14 Goto It is available on the Buffer menu.

This will cause the cursor to move to the location in the buffer specified. If the selected
value is larger than the buffer size, you are informed. 

Note: The buffer size changes depending on the device selected. 

5.15 Find It is available on the Buffer menu.

Find is used to search for a hex value in the buffer.

Simply enter the Hex Value you wish to find in the small dialogue box and hit the Find
First button. If the value is found the cursor will be moved to that location and you will
also notice that the Find First button has now changed to Find Next. You can use this to
repeat your search and find the next occurrence.

Click the mouse on Done or use tab and enter keys to close the Find dialogue box.

5.16 Device Empty 
Check

Device Empty Check is a programming function that is available on the Program menu.

This checks to see that the device is blank, i.e. all locations contain FF.

Note: This function is only really useful when working with One-Time-Programmable 
(OTP) Devices or UV Erasable Devices. It has no real use with the Atmel Flash 
Range, but provides a quick and easy way to check if a device is blank. 

5.17 Program Device Program Device is a programming function.

It is available on the Program menu, or on the above button on the speed bar (On the
speed bar, it will program the current buffer into the appropriate memory space in the
device - Code or EEPROM data depending on which window is currently ‘Focused’)
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This option Programs & Verifies each location, from the selected buffer window into the
appropriate location in the device.

Note: It is advisable to erase the device before programming unless you are adding 
extra data to existing data in the device. 
If you are changing data then you cannot change any programmed bit from a 0 
to a 1 without erasing the device first. You can however change a bit from a 1 to 
a 0. So BB could be changed to AA for example but AA cannot be changed to 
BB. You will not be able to program the device if the write lockbit has been set.
If this function is selected from the Program Menu, it will only program the PRO-
GRAM MEMORY. In devices which also have EEPROM MEMORY available, 
you must use the PROGRAM EEPROM command. 

The Program Device speed button will carry out either the PROGRAM MEMORY or
PROGRAM EEPROM command, depending on which buffer is on top of the desktop.

5.18 Verify Device Verify device is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This Verifies each location in the program memory buffer window with the appropriate
location in the device.

Note: This function will only verify the PROGRAM MEMORY.   In devices which also 
have EEPROM MEMORY available, you must use the VERIFY EEPROM com-
mand.

The Speed button will either Verify the Program or EEPROM memory, depending on
which buffer is currently selected.

5.19 Program 
EEPROM 

Program EEPROM is a programming function.

It is available on the program menu, or on the above button on the speed bar. The
speed button will program the current buffer into the appropriate memory space in the
device, depending on which window is currently Focused.

This Programs & Verifies each location, in the EEPROM memory buffer window into the
appropriate location in the device.

Note: As the EEPROM features an auto-erase function, it does not require a chip- 
erase to be performed prior to programming. A chip-erase is only required if the 
lock bits are set.

The Speed button will either Program the Code or EEPROM memory, depending on
which buffer is currently selected. 

5.20 Verify EEPROM Verify EEPROM is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This Verifies each location, in the EEPROM buffer window with the appropriate location
in the device.

The EEPROM buffer must be selected (on top) if the Speed button is used. 
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5.21 Read Device Read Device is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This will Read each location in the Device into the appropriate location in the program
memory buffer window.

Note: This will overwrite any existing data in the buffer, and this will also not read 
EEPROM MEMORY unless the speed button is used with the EEPROM data 
window selected.

5.22 Read EEPROM Read EEPROM is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This will Read each EEPROM location in the Device into the appropriate location in the
EEPROM memory buffer window.

Note: This will overwrite any existing data in the EEPROM memory buffer window. 

If the speed button is used, the EEPROM data window must be on top of the desktop. 

5.23 Program 
Lockbits

Program Lockbits is a programming function.

 

It is available on the Program menu, or on the above button on the speed bar.

It will program the security lock bits according to the setting you have selected in the
Project Manager.

Warning: Setting Lockbits may mean that you will be unable to perform further verifica-
tion on the device, and disable further writing to the device, You will however be able to
re-use the device if you perform an erase.

5.24 Erase Device Erase Device is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This will erase all data from the Program Memory & EEPROM Memory, if available, on
the device.

It is advisable to always erase a device before programming.

Warning: Erasing a device will clear all data from the device permanently.
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5.25 Health Check Health Check is a programming function.

This unique function will check the device to see if it has any defects, which may prevent
it from programming correctly. So, for example, you can use it to test an old device to
see if it still works. This function also has an associated button on the toolbar.   Note that
this function will erase any data that is currently on the device.

It will report a Pass or Failure. 

5.26 Printer Port This allows you to set which printer port the programmer is currently connected to.

Simply select the appropriate printer port, and hit the Change Button.

To Cancel any changes you have made press the Cancel button.

5.27 Font Selection This allows you to set a different Font for the Buffer Windows. You may wish to do this if
you feel that the default font is a little small, or unclear. The default font is Terminal, size
10, which is set for 14-inch monitors and is probably too small for larger monitors.

As a rule of thumb, Terminal font is usually best for displaying the full ASCII character
set, as it has all the characters below 20. You will find other fonts will ‘fill’ these charac-
ters with a circumflexed Y or another similar character.

5.28 Advanced 
Options

This allows you to override Signature Byte Checking.

This is useful if you use a lot of pre-production devices which may not have signature
information included or you are using an unsupported device which has the same pro-
gramming algorithm. USE WITH CARE. 

5.29 Edit as ASCII This option allows you to change the editing mode from Hex to ASCII and back. This is
useful if a mouse or pointing device is not available.

5.30 Device 
Checksum

Reads device and calculates the check sum. It does not load the buffer with the device
contents.

5.31 Select Colors This allows you to change the color of the text in the buffer windows.

The 5 text modes and their default colors are:

The default colors can be changed selecting the data type you wish to change in the
Data Type list, and clicking on the change color button.

Text Mode Default Color

Blank Black

Load Data Blue

Edited Data Blue

Verified Data Green

Program/Verify failure Red



Device Programming

14  

Section 6

Device Programming

6.1 Device 
Orientation

Before programming a device using the programming module, the device must be
inserted correctly into the programming unit. The AVR device itself has an arrow printed
on it, which points towards pin 1 of the device. Below are the four socket types and their
orientation.

8-Pin Devices

20-Pin Devices

28-Pin Devices

40-Pin Devices

Another method of checking to see if it is inserted correctly is to check the notches on
both the device and the programming socket. At the end of the device you will notice a
notch cut out. There is also a notch cut out on the device socket which is also printed on
the board. The notch on the device must correspond with the notch in the socket.

The orientation of the device is vitally important. If you put it in the wrong way then you
may damage the device. DO NOT PLUG A DEVICE IN WITH THE POWER SWITCHED
ON or you may damage it. Similarly never remove the device with the power on.

40-pin A/D parts have different pin outs from the digital only 40-pin parts. Insure you
have inserted your device in the correct 40-pin socket on the board. The board has A/D
and Digital written inside the sockets.

Note: Do NOT insert a device in more than one socket at a time otherwise program-
ming errors will occur.

PIN 1

PIN 1

28 

PIN 1

PIN 1



 15

6.2 Voltage 
Selection

Jumper JP1 is used to select either 3.3V or 5V programming. 

For VCC = 5V remove jumper JP1 - jumper open

For VCC = 3.3V insert JP1 - jumper closed

Jumper JP2 is used to set Brown-out detector voltage.

For Brown Out = 5V insert jumper JP2 - jumper closed

For Brown Out = 3.3V remove jumper JP2 - jumper open

This should be set to the same voltage as VCC. If VCC is set to 3.3V and Brown-out is set
to 5V, then the device will be held in reset and will NOT program. See section on Brown-
out Detector for more details.

6.3 Power and Lead 
Connections

The 10-way programming lead is inserted in the box header - the key-way ensures cor-
rect orientation. The computer connections are shown in the section on Connecting the
system.

The power supply 9-15V DC or 7-12V AC is plugged into the power connector 5.5/2.1
Barrel.

The Power On/Off switch is located next to the power connector. Insert the device
before switching the power on. The power on LED should light when the power is cor-
rectly applied.

Your hardware is now ready for programming. Refer to Using the Software description
for details of programming operations.

6.4 Programming 
8-Pin Parts

As these parts are only 8-pin, the clock inputs use two of the port pins. These pins can
be used as port pins on some devices if the device is set to run on Internal Clock. The
internal clock is set by programming a fuse but this may not be set on new parts, so a
jumper is supplied to enable the device to be programmed with external clock.

We recommend that the jumper labeled Clock Sel is set to EXT when programming new
parts. The fuse setting can then be read and set to internal clock if the port pins are
required, and the jumper setting can then be changed to INT for internal clock operation. 

Note: If the internal clock fuse is set, the internal clock will operate even if an external 
clock is supplied.

If difficulties are found in programming these parts, remove the jumper set labeled Port
B especially bits 0 to 2 as these are the programming lines. 
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Section 7

Brown Out Detector

The brown out detector circuit is used to detect voltage drops. If a short glitch occurs in
the power, this circuit ensures that the processor resets properly rather than operating
randomly.

The brown out detector must be set to the same voltage as the circuit voltage, VCC—
3.3V or 5V. For 3.3V operation, jumper JP2 must be removed (jumper open) and for 5V
operation it must be closed.

These values are approximate and may vary with temperature and other factors.

If the brown out detector voltage is set to 5V and VCC is set to 3.3V, then the brown out
circuit will operate continuously and the device will be held in permanent reset. JP1 and
JP2 must be set to the same voltage, which is always 1 open and 1 closed.

Voltage Operating Voltage Hysteresis

5 Volts 4.5 Volts 200 mV

3.3 Volts 2.9 Volts 200 mV

Voltage JP1 JP2

5 Volts Open Closed

3.3 Volts Closed Open
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Section 8

Board Applications

8.1 Using Switches 
and LEDs

The LEDs are connected through a 1K resistor network to Port B.

The switches are connected to Port D.

The switches and LEDs can be disconnected if required, so to use them, ensure that the
jumpers labeled Port B and Port D are closed. The board is also marked with the port
pin connection for each switch and LED.

8.1.1 Using 8-Pin Devices 
with LEDs

The port pins on the AT90S2323 and other 8-pin parts are not connected to the correctly
labeled LEDs due to layout constraints. The actual connections are shown in the table
below:

8.2 Configuring 
Switches and 
LEDs

The ports must be correctly set in software as input or output. This is accomplished by
setting the direction control registers to 0 for input and 1 for output. Typical set up code
would be:

ldi r16,$ff  ;load immediate into temp storage register

out DDRB,r16 ;PORTB (LED’s) is all outputs

ldi r16,$00 ;load immediate into temp storage register

out PORTB,r16 ;switch all the LEDs on

out DDRD,r16 ;set direction register to zeros for input

8.3 Using External 
Connections

All the ports are brought out to headers on the edge of the board but there are differ-
ences for different sockets which are described separately. Port B has current limit
resistors for programming on Pin7, Pin6 and Pin 5 MOSI, MISO and SCK so these port
pins will only supply a reduced current if used as outputs - 300 micro Amps @ 3.3V and
500 micro Amps @ 5V. As inputs, they will behave normally so any user circuit should
aim to use Port B for inputs.

n 28-pin socket: for Analog parts. This is connected differently, and is described 

separately below.

n 40-pin socket - A/D Parts: Port A is connected to header marked Analog not the one 

labeled Port A. Port B, Port C and Port D are the same as the 40-pin digital socket.

n 40-pin socket - Digital Parts: Connected to headers marked Port A, Port B, Port C and 

Port D.

Processor Pin LED Label Socket Pin Number

PB0 PB5 5

PB1 PB6 6

PB2 PB7 7

PB3 PB3 2

PB4 PB4 3
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n 20-pin socket: Port B and Port D are connected to headers marked Port B and Port D.

n 8-pin socket: is connected to Port B with a slightly different layout and this is also 

described separately.

In addition to the port pins, each header has a connection for ground and Vcc to supply
external circuits. Note this voltage VCC will be either 3.3V or 5V depending on the setting
of jumper 1 JP1 and the brown out detector will operate as normal (see Section 8).

Note: If your circuit is to draw significant current >250 mA then a heat sink will be 
required on the on-board regulator - LM317. This device is rated at 1.5 Amps 
but it does need a heat sink to supply this current. If your circuit will draw more 
than 1 amp, you may need a separate power supply.

8.3.1 20-Pin and 40-Pin 
Digital Sockets

The ports on the 40-pin digital socket are connected to the headers marked Port A, Port
B, Port C and Port D. The 20-pin socket is connected to the headers marked Port B and
Port D. The layout of all the headers is the same and is shown in the first diagram.

8.3.2 40-Pin A/D Socket The layout shown above applies to Port B, Port C and Port D on these parts. Port A is
the Analog input port on these devices and is connected to the header marked Analog
NOT Port A. The layout of this header and how to use the A/D functions is described in
the section Using Analog Parts.

8.3.3 28-Pin Socket This socket is also for A/D parts. There are three ports on this device - Port B, Port C
and Port D. 

Port C is the Analog input port and so it is connected to the header marked Analog NOT
Port C. See the section on Using Analog Parts for details.

Port D is connected as normal - see diagram above.

BIT 7 OF PORT.
SAME FOR ALL PORTS

EXTRA CONNECTION
FOR VCC

CUT CORNER
SHOWN ON BOARD
FOR ORIENTATION

BIT 0 OF PORT.
SAME FOR ALL PORTS

EXTRA CONNECTION
FOR GROUND
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Port B only has six bits PB0 - PB5 but these are connected to bits 2 to 7 on the header
to match the functionality of the other devices. This is shown in the next diagram.

8.3.4 8-Pin Socket The 8-Pin socket only has 5 Port bits connected: PB0- PB4. These are connected the
header marked Port B, but they are not connected to the headers in the same way as
the other sockets. The connections for this socket on the Port B header are shown
below:

8.3.5 Misc. Header The last header labelled Misc. has connections to processor pins other than the port
pins, especially for the AT90S8515 and AT90S4414. The layout of this header is:

8.3.6 All Sockets If external operations do not want pull-ups on the port pin, both the switches and the
LEDs can be disconnected from the processor. To isolate the LEDs, remove the jumper
set labeled Port B, and to isolate the switches, remove the jumper set labeled Port D.

8.4 Using Analog 
Parts

40-pin Analog parts must be used in the socket marked A/D parts, and 28-pin parts must
be used in the socket marked 28-Pin. The A/D converters use the header labeled Ana-
log for the A/D inputs. So this header is connected to Port A on the 40-pin A/D socket
and Port C on the 28-pin socket. The layout of this header is shown below.

EXTRA CONNECTION
FOR VCC

CUT CORNER
SHOWN ON BOARD
FOR ORIENTATION

BIT 0 OF PORT.

EXTRA CONNECTION
FOR GROUND

1ST TWO PINS
NOT CONNECTED

NOTE IRREGULAR 
LAYOUT OF PORT PINS

EXTRA CONNECTION
FOR VCC

CUT OUT MARKED
 ON BOARD

FOR ORIENTATION

1ST THREE PINS
CONT CONNECTED

EXTRA CONNECTION
FOR GROUND

RESET FROM
ALL SOCKETS

EXTRA CONNECTION
FOR VCC

CUT OUT MARKED
 ON BOARD

FOR ORIENTATION

EXTRA CONNECTION
FOR GROUND
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Analog Port: Marked on Board

The A/D converters can use either the on-board (Internal) Voltage Reference or an
external Voltage Reference.

8.4.1 Using Internal 
Reference

To use the internal on-board Voltage Reference, the pot marked AREF is used to set the
voltage level. The voltage level can be measured with a meter connected to the header
pins labeled Analog Ref and Analog Gnd in the above diagram or from the two holes
marked Meter + and -.

8.4.2 Using External 
Reference

To use the A/D converters with an external Voltage Reference, the link marked LK1
must be cut. The voltage is applied to the pins marked Analog Ref and Analog Gnd on
the Analog header - see diagram above. 

8.5 Using External 
RAM

The AT90S8515 and AT90S4414 can be used with external SRAM. A socket is provided
for a 28-pin RAM chip and for an address latch chip. These are next to the Atmel logo on
the board.

8.5.1 RAM 
Recommendations

A low power 62256 SRAM is suggested with an access time of 70 nS. If a very fast RAM
is required, the crystal frequency may need to be increased. If a much slower SRAM is
used, the SRAM Wait State bit must be enabled in user software—see data book. The
layout of the 28-pin RAM socket is shown below, and any RAM with this pin-out could be
used.

RAM Socket pin layout

8.5.2 Address Latch The board connections are for a 74HC573 device. This device will operate reliably with
the 4 MHz crystal supplied but if a faster crystal is inserted, a faster version of this
device may be required - 74AHC573 or 74FHC573. Note that this option will alter the
EMC characteristics of the board and the CE mark will no longer be valid without retest-
ing.

CUT OUT MARKED
 ON BOARD

FOR ORIENTATION

NOT CONNECTED ON
28-PIN SOCKET

40-PIN DEVICES
ADC0 - ADC7 CONNECTED TO PORT A
PA0 - PA7
28-PIN DEVICES
ADC0 - ADC5 CONNECTED TO PORT C
PC0 - PC5

1
2
3
4
5
6
7
8
9

10
11
12
13
14

A14
A12
A 7
A 6
A 5
A 4
A 3
A 2
A 1
A 0

I /O0
I /O1
I /O2
Vss

Vcc
W E
A13
A 8
A 9

A11
O E
A10
C S
I /O7
I /O6
I /O5
I /O4
I /O3

28
27
26

21

25
24
23
22

20
19
18
17
16
15
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8.6 Using LCD 
Connections

The header marked LCD next to the 28-pin socket, is for a standard 2 x 16 LCD. The
connections are shown on the board and in the following table.

The board is designed for use with an LCD with a Hitachi driver chip built-in, with a con-
trast pin voltage of 0 to 5 Volts.   The pot next to the LCD connector not marked AREF is
used for contrast adjustment.

If you use a different LCD driver, it may have a different voltage contrast range. In order
to accommodate this, add a resistor to the board, shown above, and cut track on under-
side of board—marked cut.

This board is not designed for use with back lit LCD modules, so the extra connections
needed are not included and the power supply will not supply the current required.

The LCD can be driven in Memory Mapped or I/O Mode—see data sheet. If the crystal
has been changed to a faster crystal frequency, memory mapped operations will not
work.

8.7 Using RS232 The connection supplied is a 9-way female D-type, so a “straight through” lead is
required—not a null-modem cable.

Jumper JP3 must be closed or RXD will be disabled. RXD and TXD are on pins PD0
and PD1, therefore it is recommended that these switches are disconnected by remov-

Connection Name Function

0V Ground

+5 VCC - must be 5V

Vo Contrast

RS Register Select- A14

Wr Not Write 

E Enable

D0 Data Bit 0

D1 Data Bit 1

D2 Data Bit 2

D3 Data Bit 3

D4 Data Bit 4

D5 Data Bit 5

D6 Data Bit 6

D7 Data Bit 7

TOP EDGE OF BOARD

EXTRA RESISTOR TO
INCREASE CONTRAST.
TRACK UNDER BOARD

MARKED CUT MUST
BE CUT IF THIS 

RESISTOR IS USED

LCD CONTRAST POT



Board Applications

 22

ing the jumpers labeled Port D. JP2 is the Brown-out voltage jumper - ensure that this is
set to 3.3 or 5 Volts as required.

As this board has a 4 MHz crystal, the percentage error on the Baud Rate will be
between 0.2 and 7.8%. Replacing the crystal with a 3.6846 MHz or 4.608 MHz crystal
will reduce this error to zero but may have EMC implications.

A standard (straight through) lead is required, NOT a null-modem cable.

P
or

t 
D

P
or

t 
C

M
is

c

JP3

Port D

JP2

M A X 2 0 2

Switches
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Section 9

In-System Programming

Devices can be programmed in your circuit rather than on the board using the STK200
ISP dongle that was included in the kit. The dongle works with a 0.1” pitch header that is
mounted on your application board.

You will need to use either a multiplexer chip (such as a 4053) or wire directly to the pins
of the device. The pins on the device are connected as follows:

In addition, the system +5 Volts and Ground need to be connected to the programming
lead.

DO NOT EXCEED 5 VOLTS, 4.75 TO 5.25 VOLTS is allowed. OR YOU MAY DAMAGE
YOUR COMPUTER.   THIS WARNING APPLIES TO ANY ISP SYSTEM. 

9.1 ISP Lead Layout

Note: This is a face view of the ISP lead. Section 9.2 shows connector on user 
circuit.

Device

1200 2313
2323/
2343 4414 8515

8535/
4434

MEGA603/
MEGA103

Pin

Reset Pin1 Pin1 Pin1 Pin9 Pin9 Pin9 Pin20

MOSI 

(PDI)

PB5 

Pin17

PB5 

Pin17

PB0 

Pin5

PB5 

Pin6

PB5 

Pin6

PB5 

Pin6

PE0 

Pin2

MISO

(PDO

PB6 

Pin18

PB6 

Pin18

PB1 

Pin6

PB6 

Pin7

PB6 

Pin7

PB6 

Pin7

PE1 

Pin3

SCK

PB7 

Pin19

PB7 

Pin19

PB2 

Pin7

PB7 

Pin8

PB7 

Pin8

PB7 

Pin8

PB1 

Pin11
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9.2 ISP Header 
Layout

Note: This is a view of the header needed on user circuit, not a face view of ISP lead.

9.3 Interface Using 
Resistors 

Typical resistor values would be 1K. This circuit is fine if ports PB7, PB6 and PB5 are
used as inputs in your circuit. If Outputs are needed, especially higher than a few milli-
amps, then the multiplexed circuit is preferable.

OPTIONAL PROGRAM
INDICATOR CIRCUIT
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9.4 Using an 
Analog 
Multiplexer IC

The multiplexer select can be driven from the LED connection on the programming lead
as can a low power LED with its cathode connected to the LED connection via a suitable
resistor—1KΩ is fine. If you use this connection then the output will be low 0 during pro-
gramming and a 1 at all other times. Note that it will float if the programmer is not active,
i.e. the software is not running so you may need to use a pull-up resistor.

Note that all the pins, except ground, will float if the programmer is not active. The
device may then be programmed in the normal way.
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Section 10

Technical Support

Technical support for this product is provided by the AVR Starter Kit Support Tem. Con-
tact information is provided below.

10.1 Contact Info We would be grateful if you can pass on any errors you may find in this software. We
pride ourselves on our customer support and we can solve the problem and send you an
update very quickly via e-mail. If you wish to communicate via telephone the number is
listed below: 

Tel: (44) 1970 621 049 STK200 Technical Support Hotline

Fax: (44) 1970 621 040

e-mail: stk200_support@atmel.com

Website: www.atmel.com

We also have an extensive range of AVR development products available. Please visit
our website (http://www.atmel.com) for full details.

Software upgrades will be made available on our website.

10.2 Warranty Atmel warrants that the Product delivered hereunder shall conform to the applicable
Atmel Data Sheet or mutually agreed upon specifications and shall be free from defects
in material and workmanship under normal use and service for a period of 30 days from
the applicable date of invoice.  Products which are "samples", "design verification units",
and/or "prototypes" are sold "AS IS," "WITH ALL FAULTS," and with no warranty what-
soever.

If, during such warranty period, (i) Atmel is notified promptly in writing upon discovery of
any defect in the goods, including a detailed description of such defect; (ii) such goods
are returned to Atmel, DDP Atmel's facility accompanied by Atmel's Returned Material
Authorization form; and (iii) Atmel's examination of such goods discloses to Atmel's sat-
isfaction that such goods are defective and such defects are not caused by accident,
abuse, misuse, neglect, alteration, improper installation, repair, improper testing, or use
contrary to any instructions issued by Atmel, Atmel shall (at its sole option) either repair,
replace, or credit Buyer the purchase price of such goods.  No goods may be returned to
Atmel without Atmel's Returned Material Authorization form.

Prior to any return of goods by Buyer pursuant to this Section, Buyer shall afford Atmel
the opportunity to inspect such goods at Buyer's location, and any such goods so
inspected shall not be returned to Atmel without its prior written consent.

Atmel shall return any goods repaired or replaced under this warranty to Buyer transpor-
tation prepaid, and reimburse Buyer for the transportation charges paid by Buyer for
such goods.  The performance of this warranty does not extend the warranty period for
any goods beyond that period applicable to the goods originally delivered.
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THE FOREGOING WARRANTY CONSTITUTES ATMEL'S EXCLUSIVE LIABILITY,
AND THE EXCLUSIVE REMEDY OF BUYER, FOR ANY BREACH OF ANY WAR-
RANTY OR OTHER NONCONFORMITY OF THE GOODS COVERED BY THIS
AGREEMENT.  THIS WARRANTY IS EXCLUSIVE, AND IN LIEU OF ALL OTHER
WARRANTIES. ATMEL MAKES NO OTHER WARRANTIES, EXPRESS, IMPLIED, OR
STATUTORY, INCLUDING WITHOUT LIMITATION ANY WARRANTIES OF MER-
CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  THE SOLE AND
EXCLUSIVE REMEDY FOR ANY BREACH OF THIS WARRANTY SHALL BE AS
EXPRESSLY PROVIDED HEREIN.

LIMITATION ON LIABILITY

Notwithstanding anything to the contrary contained herein, Atmel shall not, under any
circumstances, be liable to Buyer or any third parties for consequential, incidental, indi-
rect, exemplary, special, or other damages.  Atmel's total liability shall not exceed the
total amount paid by Buyer to Atmel hereunder.  Atmel shall not under any circum-
stances be liable for excess costs of reprocurement.
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Section 11

Appendix I

Corporate Headquarters
2325 Orchard Parkway
San Jose, CA 95131
TEL (408) 441-0311
FAX (408) 487-2600

Europe
Atmel U.K., Ltd.
Coliseum Business Centre
Riverside Way
Camberley, Surrey GU15 3YL
England
TEL (44) 1276-686677
FAX (44) 1276-686697

Asia
Atmel Asia, Ltd.
Room 1219
Chinachem Golden Plaza
77 Mody Road
Tsimshatsui East
Kowloon, Hong Kong
TEL (852) 27219778
FAX (852) 27221369

Japan
Atmel Japan K.K.
Tonetsu Shinkawa Bldg., 9F
1-24-8 Shinkawa
Chuo-ku, Tokyo 104-0033
Japan
TEL (81) 3-3523-3551
FAX (81) 3-3523-7581


